

    
      
          
            
  
માય સ્કૂલ સર્વર માર્ગદર્શિકામાં આપનું સ્વાગત છે!



	ઉપયોગકર્તા મેન્યુઅલ વિશે
	મહત્વપૂર્ણ સૂચના

	પ્રતિબંધિત અધિકારો

	સંપર્ક કરવો





	ઉપયોગકર્તા નું સંચાલન
	નવું યુઝર બનાઓ

	પાસવર્ડ ને બદલો

	ઘણા બધા યુઝર એડ કરવા માટે

	ડિફૉલ્ટ ઓળખાણપત્ર





	નેટવર્ક કોન્ફિગરેશન
	નેટવર્ક મેનેજર દ્વારા





	મોનીટરીંગ અને બ્રોડકાસ્ટિંગ
	Epoptes





	કંટેન્ટ પ્લેટફોર્મ
	વેબ સર્વર





	Linux ને ઘરે લય જાઓ
	લાઈવ usb બનાઓ





	બેકઅપ અને રિકવરી
	પૂર્વ લોડ સામગ્રી સ્થાનો





	મુશ્કેલીનિવારણ
	બુટીંગ અથવા ફ્રીઝિંગ પ્રોબ્લેમ

	ટોપ પેનલ નું ગુમ થવું

	ડિફૉલ્ટ સેટિંગ્સ પર ડેસ્કટૉપને પુનઃસ્થાપિત કરો

	રિમોટ ડેસ્કટોપ નું કનેક્શન લેવાના મુદ્દાઓ





	દૂરસ્થ સપોર્ટ
	વાઇફાઇ / હોટસ્પોટ કનેક્ટ કરો





	સપોર્ટ અને માર્ગદર્શન
	વારંવાર પૂછાતા પ્રશ્નો

	કેવી-રીતે વિડિઓઝ અને માર્ગદર્શિકાઓ

	વોરંટી સપોર્ટ ચેનલો

	મહત્વપૂર્ણ લિંક્સ

	કોમ્યુનિટી સપોર્ટ





	સંપર્ક કરવો
	કોર્પોરેટ હેડક્વાર્ટર્સ

	સામાજિક
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ઉપયોગકર્તા મેન્યુઅલ વિશે

આ પુસ્તક માં રોજ ના કામો માટે માર્ગદર્શન આપેલું છે જેની જરૂર વ્યવસ્થાપક (કમ્પ્યુટર લેબ ઇન-ચાર્જ, શિક્ષક) દ્વારા આવશ્યક હોઈ શકે છે. એવું માનીને ચાલીયે છે કે વ્યવસ્થાપક ને લિનક્સ ડિસ્ટ્રીબ્યુશન માં કામ કરવા માટે મૂળભૂત જાણકારી છે , સર્વરનો ઉપયોગ શાળાઓમાં લિનક્સ વિષયને શીખવવા માટે કરવામાં આવે છે. સર્વર નું વ્યાપક માર્ગદર્શન આપવું આ દસ્તાવેજનાં વિસ્તાર થી બહાર છે.

"ઉપયોગમાં સરળતા" ને ધ્યાનમાં રાખતા અમે માય સ્કૂલ સર્વર બનાવ્યું છે, જેનાથી ઘણા બધા કાર્યો (બધા તો નહીં) પરિપૂર્ણ કરી શકાય છે RTFM [https://en.wikipedia.org/wiki/RTFM] કર્યા વિના, તે છતાં એ સમજવું કે આ ઉપકરણ ઘણું જટિલ તકનીકો ને માડવી ને બનેલું છે જેનાથી “છાપરા ની અંદર” કંઈપણ પૂર્ણ થઈ સકે.  એડમિનિસ્ટ્રેટરને કમ સે કમ નીચે આપેલ સૂચનાઓ ને જોવું આવશ્યક છે અને માર્ગદર્શિકા જે એપ્લિકેશન્સ અથવા ઑનલાઈન દ્વારા પ્રદાન કરવામાં આવેલ છે એનું પાલન કરવું આવશ્યક છે.


મહત્વપૂર્ણ સૂચના

રેશેશે ટેક એ પ્રકાશન એ આ સૂચના આપી છે પ્રકાશન ના સમયે એને વિશ્વસનીય માનતા, પરંતુ એને કોઈ પણ પ્રકાર ની વોરંટી વગર રજૂ કરવામાં આવી છે. ઉત્પાદો ના પ્રયોગ ની સંપૂર્ણ જવાબદારી ઉપયોગકર્તા પર રહેસે. રેશેશે આ દસ્તાવેજમાં દેખાતી કોઈ પણ ભૂલ ની કોઈ જવાબદારી નહી લે. રેશેશે પોતાની પાસે અધિકાર રાખે છે, કે એ કોઈ પણ નોટિસ વિના પ્રોડક્ટ ના ડિઝાઇન અથવા સ્પષ્ટીકરણોમાં ફેરફાર કરી સકે છે.  સૂચના નોટિસ વિના ફેરફાર માટે આધીન છે.




પ્રતિબંધિત અધિકારો

કૉપિરાઇટ 2016-2018 રેશેશે ટેક એલએલપી. બધા હકો અમારી પાસે રાખેલા છે.

માય સ્કૂલ સર્વર, માય સ્કૂલ કૂલ  સર્વર લોગો, રેશેશે ટેક  એલએલપીના ટ્રેડમાર્ક છે.




સંપર્ક કરવો
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કોર્પોરેટ હેડક્વાર્ટર્સ


રેશેશે ટેક એલએલપી

501 / બી, સિનર્જી બિલ્ડીંગ, એલ-74, કોર્પોરેટ રોડ, મકરબા, અમદાવાદ,

ગુજરાત 380015. ભારત.

ફોન: +91-79-40080440

વેબસાઇટ: http://www.myscoolserver.com

પ્રાદેશિક અને તાજેતરની સંપર્ક માહિતી માટે http://www.myscoolserver.com/contact.






સામાજિક


	ટ્વિટર

	https://www.twitter.com/myscoolserver



	ફેસબુક

	https://www.facebook.com/myscoolserver



	Google+

	https://plus.google.com/+Myscoolserver













          

      

      

    

  

    
      
          
            
  
ઉપયોગકર્તા નું સંચાલન


નવું યુઝર બનાઓ

Admin-Desktop માં બુટ કરો, mssadmin થી લૉગિન કરો અને આ સ્ટેપ્સ નું પાલન કરો –

GUI દ્વારા


	નેવિગેટ કરો - સિસ્ટમ → એડમિનિસ્ટ્રેશન → યુજર્સ એન્ડ ગ્રૂપ્સ


	+Add બટન ને દબાવી ને નવા યુઝર ને એડ કરો અને વિગતો ભરો. (મોજૂદા યુઝર લિસ્ટ લોડ થાય ત્યાં સુધી તમને વાટ જોવી પડસે.)


	આગલા ડાયલોગ માં નવા યુઝર નું પાસવર્ડ સેટ કરો




ટર્મિનલ દ્વારા

sudo useradd -m <username>





પૂછવા પર mssadmin નું પાસવર્ડ નાખો અને આગડ વધો.

યુઝરના એકાઉન્ટને સક્રિય કરવા માટે પાસવર્ડ સેટ કરો.

sudo passwd <username>






યુઝર ને epoptes group માં એડ કરો


Note

આ ફક્ત શિક્ષકો ના અકાઉંટ માજ કરવું કેમકે આ અધિક અધિકારો આપે છે.



Admin-Desktop માં બુટ કરો, mssadmin થી લૉગિન કરો અને ટર્મિનલ પર જઈને નીચે દીધેલાં કમાન્ડ ને ચલાઓ –

sudo usermod -a -G epoptes <username>





પૂછવા પર mssadmin નું પાસવર્ડ નાખો અને આગડ વધો.






પાસવર્ડ ને બદલો


તમારા પોતાના પાસવર્ડ ને બદલવા માટે

GUI દ્વારા

Alt+F2 -> ltsp-remoteapps users-admin





Change... ને દબાઓ Password  લેબલ ની સામે. આના પછી Change User Password ડાયલોગ માં તમારું પાસવર્ડ બદલો.

ટર્મિનલ દ્વારા

Alt+F2 -> ltsp-remoteapps xterm -> passwd








બીજા યુઝર નું પાસવર્ડ બદલવા માટે

Admin-Desktop માં બુટ કરો, mssadmin થી લૉગિન કરો અને આ સ્ટેપ્સ નું પાલન કરો -

GUI દ્વારા


	નેવિગેટ કરો - સિસ્ટમ → એડમિનિસ્ટ્રેશન → યુજર્સ એન્ડ ગ્રૂપ્સ


	જે યુઝર નું પાસવર્ડ બદલવું છે એને સિલેક્ટ કરો


	Password લેબલ ની સામે change... દબાઓ


	પૂછવા પર mssadmin નું પાસવર્ડ નાખો


	Change User Password ડાઈલોગ માં નવું પાસવર્ડ નાખો




ટર્મિનલ દ્વારા

sudo passwd <username>





પૂછવા પર mssadmin નું પાસવર્ડ નાખો અને આગડ વધો.






ઘણા બધા યુઝર એડ કરવા માટે

ઘણા બધા યુઝર્સ ને એકજ વાર માં જોડવા માટે, Admin-Desktop માં બુટ કરો, mssadmin* થી લૉગિન કરો અને આ સ્ટેપ્સ નું પાલન કરો -


	સ્પેસ થી અલગ કરેલી ફાઇલ બનાઓ જેમાં “યુઝરનેમ પાસવર્ડ” હોય જેમ કે આ sample.


સ્ટેપ્સ:


	LibreOffice Calc ના ઉપયોગ થી ફાઇલ બનાઓ


	File -> Save as નું ચયન કરો. તમને Save as ડાયલોગ દેખાસે.


	File type માં Text CSV (.csv) ફૉર્મટ સિલેક્ટ કરો.


	ફાઇલ નું નામ users.csv દાખલ કરો અને Save પર ક્લિક કરો.


	Export of text files ડાયલોગ જે દેખાય છે, ફિલ્ડ ડેલિમીટર ના રૂપ માં {space} સિલેક્ટ કરો ડેટા નું નિકાસ કરવા માટે અને OK પર ક્લિક કરો.












Note

ફાઇલ માં એક પણ લાઇન ખાલી ન હોવી જોઈએ.




	ટર્મિનલ ને ઓપન કરીને આ કમાન્ડ ને ચલાવો –




sudo massuseradd <path_to_csv_file>





ઉદાહરણ માટે:

sudo massuseradd /home/mssadmin/users.csv








ડિફૉલ્ટ ઓળખાણપત્ર

પેલા થી કોનફિગર કરેલા નીચે દીધેલાં યુઝર અકાઉંટ સાથે જ આ ઉપકરણ ને મોકલવા માં આવે છે અર્થાત ઓર્ડર દેતા વખતે કઈં ફેર બદલ નથી કરેલો ­­­–








	અકાઉંટ ના પ્રકાર

	યુઝરનેમ

	પાસવર્ડ





	Admin

	mssadmin

	myskool



	Student

	student<n>

	12345



	Teacher

	teacher<n>

	imteacher







Warning

આ વાત પર ખૂબ અજ જોર દીધેલું છે કે યુઝર પ્રથમ વાર ઉપયોગ વખતે અકાઉન્ટ પાસવર્ડ આવશ્યક રૂપ થી બદલે.









          

      

      

    

  

    
      
          
            
  
નેટવર્ક કોન્ફિગરેશન


નેટવર્ક મેનેજર દ્વારા

MSS બે પૂર્વવ્યાખ્યાયિત નેટવર્ક કન્ફિગરેશંસ સાથે આવે છે: સ્ટેટિક અને ડાયનેમિક.

યદિ તમારા નેટવર્ક માં પેલ્લા થી જ DHCP સર્વર છે જે તમારા LAN થી જોડાયેલા ડિવાઇસ ને IP એડ્રેસ આપે છે તો તમને MSS ડાયનેમિક મોડ માં કંફિગર કરવું પડસે. યદિ એવું કોઈ DHCP સર્વર નથી , તો MSS ને સ્ટેટિક મોડ માં કંફિગર કરવું પડસે.

આ માનવું સેફ છે કે લગભગ બધાજ કેસ માં જ્યાં નવું નેટવર્ક સેટઅપ કરવામાં આવ્યું છે MSS ને ઇન્સ્ટોલ કરવા માટે, ત્યાં કોઈ પેલ્લા થી મૌજૂદ DHCP સર્વર નહી હોય, એટ્લે તમે સેફલી સ્ટેટિક  સર્વર ને પસંદ કરી સકો છો.

સ્ટેટિક અને ડાયનેમિક મોડ માં કેવી રીતે કંફિગર કરવું તે નીચે સમજાવ્યું છે:

લૉગિન કર્યા પછી જે કનેક્શન નું ઇસ્તેમાલ નથી કરી રયા તેને એડિટ કરો અને “આ નેટવર્કમાં આપમેળે જોડાવો જયારે તે ઉપલબ્ધ છે” ને અનચેક કરો , આવું કરવાથી અનિચ્છિત મોડમાં ઓટો- કનેક્શન ના પ્રયાસો અક્ષમ થઈ જસે. ઉદાહરણ ના તૌર પર અઇયાં નીચે, અમે 'ડાયનેમિક' મોડે ને અક્ષમ કરી 'સ્ટેટિક' મોડને સક્ષમ કરી રહ્યા છે.


[image: Network Manager - Edit Connections]


નેટવર્ક મેનેજર - કનેક્શન ને એડિટ કરવું


[image: Network Connections Window]


નેટવર્ક કનેક્શન્સ


[image: Editing dynamic window]


ડાયનેમિક મોડને બંધ કરવા માટે અનચેક કરો


[image: Editing static window]


સ્ટેટિક મોડ પર સ્વિચ કરવા માટે ચેક કરો

છેલ્લે, નેટવર્ક મેનેજર મેન્યૂ માં જઈને "સ્ટેટિક" પસંદ કરો અને તમારું MSS હવે સ્ટેટિક મોડ માં કાર્ય કરી રહ્યું છે.







          

      

      

    

  

    
      
          
            
  
મોનીટરીંગ અને બ્રોડકાસ્ટિંગ


Epoptes

Epoptes એક મોનીટરીંગ અને બ્રોડકાસ્ટિંગ ટૂલ છે જે શિક્ષકો ને પાઠ આપવા માં મદદ કરે છે.

જે યુઝર “epoptes” સમૂહ થી જોડાયેલા છે ફક્ત એજ લોકો epoptes એપ્લીકેશન લોંચ કરી સકે છે, જુવો યુઝર ને epoptes group માં એડ કરો.

જે શિક્ષકો ના અકાઉંટ પેલા થી કોન્ફિગર કરેલા છે એ લોકો પહેલેથી જ epoptes સમુહ ના સદસ્યો છે. Epoptes નું ઉપયોગ આત્મ સ્પષ્ટ અને સાહજિક છે, જોકે એનું સંપૂર્ણ દસ્તાવેજીકરણ અહીં [https://translate.google.com/translate?u=http://ts.sch.gr/wiki/Linux/epoptes] ઉપલબ્ધ છે.

અગર શિક્ષક English-Desktop નું ઉપયોગ કરે છે તો, નીચે દીધેલાં માર્ગ પર જઈને Epoptes શરૂ કરી સકે છે:

Alt+F2 -> ltsp-remoteapps epoptes






Epoptes લોંચર બનાવું

નીચે દીધેલાં ચરણો નું પાલન કરીને શિક્ષકો Epoptes ને એક ક્લિક થી શરૂ કરવા માટે ડેસ્કટોપ લોંચર બનાવી સકે છે.


	ડેસ્કટોપ પર રાઇટ ક્લિક કરો અને સિલેક્ટ કરો શરુ કરનાર બનાવો (a)...


	શરુ કરનાર બનાવો સંવાદમાં નીચેના પગલાઓ કરો -


	નામ માં Epoptes દાખલ કરો


	આદેશ માં ltsp-remoteapps epoptes દાખલ કરો


	બરાબર દબાઓ









[image: Monitoring and Broadcasting - Epoptes Launcher]



Note

નવું બનાવેલું લોંચર જોવા માટે તમને ડેસ્કટોપ ને રિફ્રેશ (F5) કરવુ પડસે











          

      

      

    

  

    
      
          
            
  
કંટેન્ટ પ્લેટફોર્મ


વેબ સર્વર

માય સ્કૂલ સર્વર પેલા થી જ કોન્ફિગર કરેલું આવે છે, જેમાં ઉપયોગ માટે તૈયાર વેબ સર્વર આવે છે જે તમારું કંટેન્ટ હોસ્ટ કરવામાં તમને સહાયતા કરે છે અને એને સ્થાનિક નેટવર્ક પર તેને ઉપલબ્ધ કરાવે છે.

હોસ્ટ કરેલું કંટેન્ટ MSS દ્વારા સંચાલિત કોઈ પણ ક્લાઈંટ અથવા કોઈ પણ વેબ બ્રાઉજર થી ઍક્સેસ કરવામાં આવે છે નીચે દીધેલા માર્ગ થી -

http://server/






કસ્ટમ કન્ટેન્ટને હોસ્ટ કરવા માટે

Admin-Desktop માં બુટ કરો પછી mssadmin તરીકે લૉગિન કરો અને તમારા કસ્ટમ કન્ટેન્ટને નીચે બતાવેલ જગ્યા પર મુકો –

/var/www/html/mss/custom





કસ્ટમ કન્ટેન્ટ ટાઇલના કસ્ટમાઇઝેશન માટેના સૂચનો બ્રાઉઝર દ્વારા -

http://server/mss/custom






Note

નીચે પ્રમાણે હોસ્ટ થવાની બધી કન્ટેન્ટ ને લઘુત્તમ પરવાનગીઓ હોવી જોઇએ તેની ખાતરી કરો - ફોલ્ડર્સ માટે read અને execute અને ફાઇલો માટે read.



ટર્મિનલ દ્વારા આવશ્યક પરવાનગીઓ સેટ કરો

આવશ્યક પરવાનગીઓ સેટ કરવા માટે ટર્મિનલમાં નીચેના કમાંડ ચલાવો -

sudo find /var/www/html/mss/custom -type d -exec chmod a+rx {} \;
sudo find /var/www/html/mss/custom -type f -exec chmod a+r {} \;








વ્યક્તિગત કન્ટેન્ટ હોસ્ટીંગ

દરેક ઉપયોગકર્તા ને પોતાના HTML આધારિત વેબ કન્ટેન્ટને હોસ્ટ કરવાની જરૂર હોઈ શકે છે. દરેક ઉપયોગકર્તા પોતાની વ્યક્તિગત કન્ટેન્ટને અહીં હોસ્ટ કરી શકે છે -

/home/<username>/public_html





અને બધા સંબંધિત ક્લાઈંટસ આને અહીં થી ઍક્સેસ કરી સકે છે

http://server/~<username>






Note

નીચે પ્રમાણે હોસ્ટ થવાની બધી કન્ટેન્ટ ને લઘુત્તમ પરવાનગીઓ હોવી જોઇએ તેની ખાતરી કરો - ફોલ્ડર્સ માટે read અને execute અને ફાઇલો માટે read.











          

      

      

    

  

    
      
          
            
  
Linux ને ઘરે લય જાઓ


લાઈવ usb બનાઓ

Li-f-e: Linux for Education OS છબી સર્વર માં શામિલ કરેલી છે અને બૂટટેબલ મીડિયા બનવામાં ઉપયોગ માં આવે છે જ્યારે તમે  Admin-Desktop માં બૂટ કરી ને mssadmin થી લૉગિન કરો છો.


	નોટ

	“isohybrid” / “EFI” ઓપ્શન ને સિલેક્ટ કરો જ્યારે તમે બૂટટેબલ મીડિયા બનાઓ છો જે તે કોમ્પ્યુટર્સ  ને બૂટ કરસે જે ફક્ત EFI બૂટિંગ ને સપોર્ટ કરે છે. આ ઓપ્શન લેગેસી હાર્ડવેર ને પણ બૂટ કરે છે, તો અગર તમને તમારા હાર્ડવેર ની ક્ષમતા ની ખાતરી ના હોય ત્યારે આનું ઉપયોગ કરો.

“isohybrid” ઓપ્શન નો પ્રયોગ બૂટટેબલ USB બનવા માટે નો એક આધિકારિક માર્ગ છે, અને એટલા માટે અધિક વિશ્વસનીય છે. આ વાત ને નોટ કરજો કે આ કરવાથી આ USB ડિવાઇસ ને સાફ કરી દેસે અને આનું ઉપયોગ Windows PC માં સામાન્ય સ્ટોરેજ મીડિયા તરીકે નહીં કરી સકાય.

“Ubuntu” / “Legacy” ઓપ્શન નો પ્રયોગ કરો યદી તમે ડિવાઇસ ને વિંડોસ પર સ્ટોરેજ મીડિયા તરીકે ઉપયોગ કરવા માંગો છો અથવા તમારા ડેટા ને સાચવા માંગો છો. આ પદ્ધતિ માટે તમને  USB સ્ટિક પર એક vfat ફોરમેટેડ પાર્ટીશન ની જરૂર છે. બૂટ મીડિયા બનાવતા વખતે પાર્ટીશન ઉપયોગ માં ના હોવું જોઇયે. અગર આ પદ્ધતિ ના ઉપયોગ પછી બૂટિંગ નિષ્ફળ જાય છે તો isohybrid / EFI મોડ નું પ્રયોગ કરો.






શૉર્ટકટ્સ દ્વારા

આમાં થી કોઈપણ લોંચર આઈકન ડેસ્કટોપ પર પ્રયોગ કરો -Live USB GUI EFI અથવા Live USB GUI Legacy તમારા બૂટટેબલ મીડિયા પ્રેફેરેંસ ને ધ્યાન માં રાખતા.




મેન્યૂ દ્વારા

System Tools -> Live USB GUI





ઉપર દીધેલી પ્રક્રિયા માં તમને ISO છબી માંગવા માં આવસે. Li-f-e.iso આમાં થી કોઈ પણ એક ડાઇરેક્ટરી પાઠ પર ઉપલબ્ધ છે - /recovery/ અથવા /home/mssadmin/.




ટર્મિનલ દ્વારા

આ કાર્યને ઘણી વખત ચલાવવા માટે કમાન્ડ લાઇન નું ઉપયોગ કરવું વધુ અનુકૂળ હોઈ શકે છે.

sudo live-grub-stick --isohybrid /recovery/Li-f-e.iso /dev/sdb








સંદર્ભ

નીચે દીધેલી બાહ્ય કડીઓ (ઇન્ટરનેટ ની આવશ્યકતા પડસે) જુવો એ શીખવા માટે કે USB સ્ટિક ને કઇ રીતે બૂટ કરવું અને બૂટ ના થવા પર મુશ્કેલીનિવારણ કેમ કરવું:

BIOS ના બૂટ ઓર્ડર માં પરીવર્તન કરો [https://www.lifewire.com/change-the-boot-order-in-bios-2624528]

USB ડિવાઇસ થી બૂટ કરો [https://www.lifewire.com/how-to-boot-from-a-usb-device-2626091]









          

      

      

    

  

    
      
          
            
  
બેકઅપ અને રિકવરી

અમે આ સમજયે છે કે દુર્ઘટનાઓ થતી રહે છે અને હર એક ને બીજો મોકો મળવો જોઇયે. ઓપન-સોર્સ હોવાના ને નાતે કોઈ નું પણ મન સર્વર સાથે રમવાનું થઈ સકે છે અને એવું કરવા પર અમે કોઈ પ્રકાર નું દંડ નથી લગાડતા. My sCool Server અહી થી Factory Restore ઓપ્શન આપે છે –


	સર્વર બૂટ મેન્યૂ અથવા


	recovery.sh દ્વારા બનાવેલી usb




ફેકટ્રી રિસ્ટોર ઓપ્શન સિસ્ટમ ને રિસ્ટોર કરે છે અને એજ અવસ્થા માં પાછું લાવે છે જ્યારે એણે રેશેશે નું સ્થળ છોડ્યું હતું, જેમાં યુઝર ના અકાઉંટ માં કરેલા પરિવર્તનો પણ શામિલ આદિ., અગર ડેટા ઓર્ડર પ્લેસમેન્ટ વખતે આપેલું હતું.


Warning

Factory Restore નો ઉપયોગ કરતા પહેલાં સાવધાની રાખવી. વપરાશકર્તા દ્વારા સર્વર પર કરવામાં આવતી કોઈ પણ કસ્તામૈઝેસન ને ઓવરરાઇડ કરશે અને તેને ફેક્ટરી શિપિંગ સ્ટેટમાં પુનઃસ્થાપિત કરશે. તે વપરાશકર્તા દ્વારા બનાવેલ ડેટા પણ કાઢી શકે છે. આથી, જો વપરાશકર્તાએ બનાવેલું માહિતી મૂલ્યનો છે, તો તે ખૂબ આગ્રહણીય છે કે / home નો ડેટા સમયાંતરે બાહ્ય મીડિયાનો ઉપયોગ કરીને નીચેના પગલાંઓનું પાલન કરો.




Note

Factory Restore સુવિધા કોઈ પહેલાથી લોડ અથવા કસ્ટમ લોડ કરેલી વેબ-સામગ્રીને પુનઃસ્થાપિત કરતી નથી. http://server દ્વારા બધી સામગ્રીનું બૅકઅપ અને પુનઃસંગ્રહ એ વપરાશકર્તાની જવાબદારી છે. સરળ અને ઉપયોગી બેકઅપ પગલાં માટે નીચે વાંચો.



મલ્ટીપલ સ્નેપશોટ બનાવી શકાય છે.રિકવરી પાર્ટીશન પર જેટલી જગ્યા છે એટલા પરજ કામ કરી શકાય છે. MSS બોર્ગ દિડુપ્લિકેટેડ બેકપ નું પ્રયોગ કરે છે, જેનો અર્થ છે કે જે બદલાવ સિસ્ટમ માં પાછલા બેકઅપ પછી કરેલા છે એ પછી કરેલા બેકઅપ અટૈમ્પ્ટ માં સંગ્રહિત કરવામાં આવશે.


	બેકઅપ બનવા માટે નીચે આપેલા કમાન્ડ ને રૂટ (sudo su -) ના રૂપ માં ચલાવો:




recovery.sh create






	ચાલુ સિસ્ટમ માથી ફેક્ટરી ઇમેજ રિસ્ટોર કરવા માટે, નીચે આપેલા કમાન્ડ ને રૂટ (sudo su -) ના રૂપ માં ચલાવો:




recovery.sh restore [optional snapshot number]






	સ્નેપશોટસ સંખ્યાત્મક છે, 1 ફેક્ટરી ઇમેજ ને દર્શાવે છે. મૂળભૂત રીતે, રિસ્ટોર ચલાવા પર સ્નેપશોટ પર રિસ્ટોર થઈ જસે. છેલ્લાં સ્નેપશોટ પર રિસ્ટોર કરવા માટે. નીચે આપેલા કમાન્ડ ને રૂટ (sudo su -) ના રૂપ માં ચલાવો:




recovery.sh restore last





સ્નેપશોટ નું સંચાલન આ દસ્તાવેજ અને ટૂલ ના વિસ્તાર થી બાહર છે. હજુ વિગતો માટે બોર્ગ દસ્તાવેજીકરણ [http://borgbackup.readthedocs.io/en/stable/usage.htm] નો સંદર્ભ લો.

અહી થોડાક ઉદાહરણો દીધેલાં છે એના પર કે borg સાથે શું કરી શકો છો:


	બધા સ્નેપશોટસ ની સૂચિ બનાવી શકો છો:




sudo borg list /recovery/system






	તમારા મન માફક સ્નેપશોટ બનાવી શકો છો, ઉદાહરણ માટે, /home નું સ્નેપશોટ બનાવા માટે:




borg init --encryption=none </backup/folder/path/home>

borg create --stats --progress --compression lz4 </backup/folder/path/home>::<snapshotname> /home






Note

/backup/folder/path/ માં જોઇયે તેટલી જગ્યા હોવી જોઇયે.




	સ્નેપશોટ થી /home ને રિસ્ટોર કરવા માટે:




borg mount </backup/folder/path/home>::<snapshotname> /mnt

rsync -avP /mnt/* /home/





રિસ્ટોરેશન પૂરું થવા પર:

umount /mnt






પૂર્વ લોડ સામગ્રી સ્થાનો

પહેલાથી લોડ કરેલી વેબ સામગ્રી મોટાભાગમાં સામાન્ય સ્થાન પર રહે છે- /var/www/html/mss. જો કે કેટલીક સામગ્રી જેમાં તેમના પોતાના કસ્ટમ સ્થાન હોય તે નીચે સૂચિબદ્ધ છે -


	NROER

	/home/docker



	Gyankunj Slate

	/home/mssadmin/slate



	ePathshala

	/home/mssadmin/.epathshala











          

      

      

    

  

    
      
          
            
  
મુશ્કેલીનિવારણ


બુટીંગ અથવા ફ્રીઝિંગ પ્રોબ્લેમ

અગર ક્લાઈંટ મશીન બૂટ ના થાય અથવા કામ કરતી વખતે ફ્રીઝ થય જાય, તો આના કારણ ખરાબ નેટવર્ક કેબલ, કનેક્શન અથવા સ્વિચ હોય સકે છે. કોશિશ કરો ક્લાઈંટ ને સર્વર થી સીધું કનેક્ટ કરવાની LAN કેબલ ની મદદ થી અને ક્લાઈંટ ને બુટ કરવાનો પ્રયાસ કરો. અગર ક્લાઈંટ બૂટ થઇ જાય છે તો એનો અર્થ છે કે ક્લાઈંટ અને સર્વર બન્ને સરખી રીતે કાર્ય કરે છે. હવે તમે તમારા ભૌતિક નેટવર્ક ના મુશ્કેલીનિવારણ પર કાર્ય કરો અથવા તમારા નેટવર્ક એંજીનિયર ને સંપર્ક કરો.

ઉપર દીધેલાં બધા ચરણો કાર્ય પછી પણ અગર ક્લાઈંટ ની મશીન ચાલુ ના થાય તો, MSS support team ને સંપર્ક કરો.




ટોપ પેનલ નું ગુમ થવું

અગર ટોપ પેનલ નથી દેખાતી, તો નીચે દીધેલાં કમાન્ડ ને ચલાવો –

Alt+F2 -> resetpanel








ડિફૉલ્ટ સેટિંગ્સ પર ડેસ્કટૉપને પુનઃસ્થાપિત કરો

ડેસ્કટૉપને કોઈ પણ વપરાશકર્તાની ડિફૉલ્ટ સુયોજનોને પુનઃસ્થાપિત કરવા માટે ટર્મિનલમાંથી mssadmin એકાઉન્ટ લોગિનમાંથી આ વપરાશકર્તા લૉગ આઉટ થયા પછી –

sudo mv /home/<username>/.config /home/<username>/.config-backup





આના પછી યુઝર ને ફરી લૉગિન કરવાનું કહો.

અથવા

ચાલતા સેશન માં થી યુઝર આ પણ પ્રયત્ન કરી શકે છે -

Alt+F2 -> resetdesktop





ફેરફારો કરવા માટે યુઝર ને  લૉગ આઉટ કરવાની અને પાછા આવવાની જરૂર પડશે.




રિમોટ ડેસ્કટોપ નું કનેક્શન લેવાના મુદ્દાઓ

નીચે દીધેલાં પગલાઓ નું પ્રયાસ કરો mssadmin યુઝર ના રૂપ માં (પૂછવા પર પાસવર્ડ દાખલ કરો) -

સેવાની સ્થિતિ તપાસો

sudo systemctl status xrdp





સેવા પુનઃપ્રારંભ કરો

sudo systemctl restart xrdp





XRDP પ્રક્રિયાઓ ચાલી રહ્યું છે તે તપાસવા માટે

ps ax | grep xrdp





XRDP સંબંધિત ફાઈલો ને લૉગ કરો

sudo tail -f /var/log/xrdp-sesman.log





Rdp લૉગિન સમસ્યાને નિદાન કરવા માટે

sudo tail -f /var/log/auth.log





એવા યુઝર થી લૉગિન કરવાનો પ્રયાસ કરો જે હમણાં સક્રિય સત્રમાં વર્તમાનમાં લૉગ ઇન થઈ શકે છે.







          

      

      

    

  

    
      
          
            
  
દૂરસ્થ સપોર્ટ

સપોર્ટ ટીમ તરફથી દૂરસ્થ સપોર્ટ મેળવવા માટે, નીચેના પગલાં નું પાલન કરો -


	કોઈ પણ અકાઉંટ થી લૉગિન કરો, નેવિગેટ કરો Applications → Internet → Remmina


	નીચે દીધેલાં પગલાં નું પાલન કરો -






	ડ્રોપ ડાઉન બોક્સ માં RDP જ સિલેક્ટ કરેલું હોય.


	server ટાઈપ કરો જેમ નીચે બતાવેલું છે.


	Connect ! દબાઓ.





[image: Remote Support - Reminna]






	જ્યારે કનેક્શન થાય જાય, Remmina સ્ક્રીન માં mssadmin તરીકે પ્રવેશ કરો.






Note

નીચે દીધેલા પગલાં ને ખુલેલી રૅમમીનાં વિન્ડો માં અમલમાં મુકો







	ઇન્ટરનેટ કનેક્શન માટે Wi-Fi/Hotspot થી કનેક્ટ કરો, વાઇફાઇ / હોટસ્પોટ કનેક્ટ કરો સેક્શન ને જુવો, Wi-Fi/Hotspot દ્વારા ઇન્ટરનેટ થી જોડાવા માટે.


	Epoptes ને લોંચ કરો Applications → Internet → Epoptes દ્વારા


	Remote support ઓપ્શન ને સિલેક્ટ કરો Help → Remote support ઓપ્શન માથી






[image: Remote Support - Epoptes]






	remote-assistance ડાયલોગ માં નીચે દીધેલાં પગલાં નું અનુસરણ કરો -






	Method માં તપાસો કે Graphic(VNC) સિલેક્ટ કરેલું છે શું.


	Host પર જઇને ટાઈપ કરો support.myscoolserver.com:5500


	જોડો દબાઓ.





[image: Remote Support - Remote Assistance]






	સફળ કનેક્શન પર, Status Connected માં બદલાઈ જશે.





વાઇફાઇ / હોટસ્પોટ કનેક્ટ કરો

MSS માં Wi-Fi/Hotspot ને કનેક્ટ કરવા માટે, mssadmin તરીકે લૉગિન કરો અને આ પગલાંઓ નું પાલન કરો -


	સ્ક્રીન ના સીધી બાજુ સૌથી ઉપર કોર્નર થી [image: internet] પર ક્લિક કરો, એને તમે જે નેટવર્ક માં જોડાવા માંગો છો તેના નામ પર ક્લિક કરો.






[image: Connect Wi-fi - Wi-fi List]



Note

અગર નેટવર્ક નું નામ સૂચિ માં નથી, તો વધારે નેટવર્કો સિલેક્ટ કરો એ જોવા માટે કે શું નેટવર્ક નું નામ સૂચિ માં હજી નીચે હોય સકે છે. અગર, તમને હજી પણ નેટવર્ક નથી દેખાતું, તો તમારું ડિવાઇસ રેન્જ ની બહાર હસે અથવા નેટવર્ક છુપાયેલું હસે.







	પરસ્થાપિત કરો ડાયલોગ માં mssadmin નું પાસવર્ડ નાખો જેમ નીચે દેખાયેલું છે તેમ અને પરસ્થાપિત કરો  ને દબાઓ.






[image: Connect Wi-fi - System Authentication]






	પરસ્થાપિત કરો ડાયલોગ સાથે એ પછી પાસવર્ડ પૂછસે, mssadmin નું પાસવર્ડ નાખો અને પરસ્થાપિત કરો ને દબાઓ






[image: Connect Wi-fi - System Authentication]






	અગર નેટવર્ક માં પણ પાસવર્ડ નાખેલો છે તો, Wi-Fi નેટવર્ક સત્તાધિકરણ જરૂરી ડાયલોગ માં પણ પૂછવા પર પાસવર્ડ દાખલ કરો અને જોડો પર ક્લિક કરો.






[image: Connect Wi-fi - Wi-fi Authentication]






	નેટવર્ક નું આઈકન [image: wifi] આમ બદલી જસે






Note

અગર કનેક્શન સફળ  નથી થતું, તો તમને ફરી પાસવર્ડ પૂછી શકે છે નહીંતર પછી તમને સરળતા થી કહી દેશે કે કનેક્શન ડિસ્કનેક્ટ થઈ ગયું છે.












          

      

      

    

  

    
      
          
            
  
સપોર્ટ અને માર્ગદર્શન


વારંવાર પૂછાતા પ્રશ્નો

વિવિધ દ્રષ્ટિકોણથી સંકળાયેલા, એમએસએસ વપરાશકર્તાઓ દ્વારા વારંવાર પૂછાતા પ્રશ્નોના જવાબો, અહીં મળી શકે છે -

http://myscoolserver.com/faqs




કેવી-રીતે વિડિઓઝ અને માર્ગદર્શિકાઓ

યુ ટ્યુબ ચેનલને મૂળભૂત વપરાશ તાલીમ અને નવી સુવિધા સાથે નિયમિતપણે અપડેટ કરવામાં આવી છે. તમારા રુચિના ક્ષેત્ર માટે પ્લેલિસ્ટ્સ વિભાગને તપાસ કરો -

https://www.youtube.com/myscoolserver




વોરંટી સપોર્ટ ચેનલો

પ્રત્યેક માય સ્કૂલ સર્વર પર વિશિષ્ટ એમએસએસ ID અથવા S/N (સીરીયલ નંબર) ધરાવતી સ્ટીકર છે. આ ID તમારા એમએસએસ હાર્ડવેરના સંદર્ભમાં રેશેશે ટેક સાથેના તમામ સંચાર માટે મહત્વપૂર્ણ છે. તમને વોરંટી માં ક્યારે પણ MSS હાર્ડવેર સંબંધી મુશ્કેલી આવે તો કોઈ પણ સપોર્ટ ચેનલ પર જઈને ટિકિટ ખોલો અને આ એમએસએસ ID ને અને તમારી સમસ્યાના પ્રકારનું ઉદ્ધરણ કરો.

સપોર્ટ પોર્ટલ: https://helpdesk.myscoolserver.com

ઇમેઇલ-આઈડી: helpdesk@myscoolserver.com

વ્હાત્સેપ નંબર: + 91-79-40080440




મહત્વપૂર્ણ લિંક્સ

સેવાની શરતો અને સપોર્ટ [https://www.myscoolserver.com/mss-service-terms/]

મર્યાદિત વોરંટી શરતો [https://www.myscoolserver.com/recherche-limited-product-warranty-mss/]






કોમ્યુનિટી સપોર્ટ


શીખવાના સાધનો

માય સ્કૂલ સર્વર હેકેટ અને બેંકવેલ કોમિક પુસ્તકો 1 અને સ્પોકન ટ્યુટોરિયલ ના સામગ્રીને પહેલાથી લોડ કરવામાં આવે છે 2 જે તમને ઉબુન્ટુ લિનક્સનો ઉપયોગ વિશે જાણવાની આવશ્યકતા દ્વારા ચાલે છે, લગભગ દરેક GUI એપ્લિકેશન F1 સાથે આવે છે. સહાય, અને સંબંધિત દસ્તાવેજો / usr / share /doc ફોલ્ડર માં છે.

કોમ્યુનિટી બનાવનાર દસ્તાવેજીકરણ અહીં ઉપલબ્ધ છે:


https://ubuntu-manual.org

https://help.ubuntu.com

https://ubuntu-mate.github.io

https://help.ubuntu.com/community/CommonQuestions

https://help.ubuntu.com/community/Beginners/FAQ

http://askubuntu.com/questions?sort=faq

https://ubuntu-mate.community/t/ubuntu-beginners-guide-complete-how-to-install-and-run-first-update/955/7

https://ubuntu-mate.org/faq






ઉબુન્ટુ કોમ્યુનિટી સહાય


http://community.ubuntu.com/help-information

https://ubuntu-mate.org/community






એમએસએસ કોમ્યુનિટી સહાય

https://github.com/RechercheTech/mss/issues




તમારી ભાષામાં લખવું

https://help.ubuntu.com/community/ibus




Li-f-e - Linux for Education સહાય

https://sourceforge.net/projects/cyberorg-home/support




કોમ્યુનિટી સહાય મેળવવા પહેલાં વાંચવું આવશ્યક છે

http://www.catb.org/esr/faqs/smart-questions.html


	1

	http://hackettandbankwell.com



	2

	http://spoken-tutorial.org/about-us













          

      

      

    

  

    
      
          
            
  
સંપર્ક કરવો
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કોર્પોરેટ હેડક્વાર્ટર્સ


રેશેશે ટેક એલએલપી

501/બી, સિનર્જી બિલ્ડીંગ, એલ 74, કોર્પોરેટ રોડ, મકરબા, અમદાવાદ,

ગુજરાત 380015. ભારત

ફોન: + 91-79-40080440

વેબ સાઇટ: http://www.myscoolserver.com

પ્રાદેશિક અને તાજેતરની સંપર્ક માહિતી માટે http://www.myscoolserver.com/contact






સામાજિક


	ટ્વિટર

	https://www.twitter.com/myscoolserver



	ફેસબુક

	https://www.facebook.com/myscoolserver



	Google+

	https://plus.google.com/+Myscoolserver
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